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1 INTRODUCTION

Visual NCES Editor (ViEd) is a graphical editor designed for developing Net Condition/Event
Systems (NCES) models. ViEd is written in Java, so you would need Java Run-time Environment
to be installed in order to run it. The developed NCES models are stored in XML files which
maximize the transferability and cross-platform capability of the designs.

Main features:

e Transferable file format

e Intuitive graphical interface
e Tab view

e Hierarchical model view

e Precise entity selection

e Instant change reflection

e Easy entity identification

2 INSTALLING VISUAL NCES EDITOR

A trial version of the ViEd is provided as a single zip archive file. Installation of ViEd only
requires extracting the archive file, which can be unzipped to any destination folder, but the
folder structure must be preserved. The following diagram shows the default folder structure
inside the archive file:
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FIGURE 2-1 DEFAULT STRUCTURE OF THE VIED FOLDER AFTER UN-ZIPPING

The src folder contains example files and standard library (in full version); the xmISchema holds
a local copy of the XML Schema used to validate the NCES models; the changelog.txt logs the
update history; the ViEd Manual.htm and folder ViEd Manual_files contain the manual for the
ViEd in HTML format and the Visual NCES Editor.exe is the executable file. After unzipping
files, ViEd is ready to run by simply double-clicking the executable file.

2.1 SYSTEM REQUIREMENTS:

ViEd was developed in Java 1.6 under Windows XP with SP2. ViEd should be able to run in any
Windows systems as long as the OS supports Java 1.6.



3 LICENSE NOTES

ViEd has been developed by the Blockdesign - the group of students of the University of
Auckland, New Zealand, supervised and managed by Dr. Valeriy Vyatkin (contact:
v.vyatkin@auckland.ac.nz).

Main developers: Cheng Pang and David Gommans.

The current trial version of ViEd is provided for free individual use for research purposes

without any warranty, responsibility and support.

All rights reserved. © BlockDesign, 2007



4 USER INTERFACE

The user interface of ViEd looks as follows:
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FIGURE 4-1 INITIAL INTERFACE OF VIED

Note: depends on your screen’s resolution, you may need to adjust the Panels’ position.
The ViEd User Interface is made up of the following components:

¢ Main Menu

e Toolbar
e Sidebar
e Panels

e Status bar

The following diagram illustrates the aforementioned interface components after a new file has
been created:
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FIGURE 4-2 COMPONENTS ON VIED USER INTERFACE

4.1 MAIN MENU

The Main Menu is located at the top of the ViEd application window, which accommodates
various commands and options. One can also access many of the Main Menu commands and
options from the Toolbar.

The Menus are:

e File

e Edit

o View

e Options
e Help

To describe pathways through the Menu system, the ‘|’ character is used to indicate a selection
on the next level of the Menu system. For example, File | Open means the command can be
accessed by selecting File from the Main Menu and then Open from the Submenu.

Shortcut keys shown as (key sequence) allow direct access to the command. For instance, File |
Open (Ctrl + O) means the command can also be accessed by pressing the Control and O keys
simultaneously.

4.1.1 FILE MENU
The File Menu enables you to work with the stored NCES model (.xml files) as a whole.

The available options are as follows:
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e SaveAs...
e Save In TNCES Format

Closing windows and exiting:

e (lose
o C(Close All
o Exit

As indicated below, unusable functions are greyed out:

Mew Chrl+n
Jpen Chrl+0

Exit Chrl+0

FIGURE 4-3 FILE MENU

New [File | New (Ctrl + N)]

Create a new blank NCES model. Multiple new files can be created and displayed in different
tabs as shown below:
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FIGURE 4-4 CREATE NEW FILES




Open [File | Open (Ctrl + O)]

Open a created NCES model XML file. When the Open menu item is clicked a File Choose
Dialog will be displayed from which the target XML file can be chosen as shown below:
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FIGURE 4-5 OPEN A XML FILE

Save [File | Save (Ctrl + S)]

Save the current NCES model as an XML file. If it is a new model, ViEd will ask for a name. If no
specific name is provided, ViEd will use the default name “New” instead. There is no need to
type in the .xml extension. If the current file has been created before, the ViEd will save the

current design back to existing file.

The Save menu item will not be usable until a new file has been created or an existing file has
been opened. If a file has previously been saved and no change has made since then, clicking
the Save menu item will not actually save the current file again.
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Save As

Save the current NCES model under a new name. There is no need to type in the .xml extension.
If the current NCES model is new, ViEd will ask for a new name.

Save In TNCES Format

Save the current NCES model in a format compatible to the TNCES Editor, developed earlier at
the University of Halle, Germany. If the current NCES model is new, ViEd will ask for a new
name.

Close [File | Close All (Ctrl + W)]

Close the current NCES model. The current active tab in the Visualization Panel will be closed.
If the current file has been saved previously, a confirmation dialog as shown below will prompt
out:




[

File Edit Wiew Options Help

DERE R A3 Bl

‘k] E Top level MNaw X |
o
Val |_. outpu
[
| — ——
E{ ‘Confirm Save Current File
| Yes | | Cancel |
&
¢ 1 > 3
k) : 2 L |
pAE—
XML | *Console|
<VersionInfo Copyright="" FileVersion="1" EditorVersion="Visual NCES Editor 1.0.0" Author=""" Date="2007-08-11" e
Description="" />
<Interfacelist />
<SNS LeftPageBorder="-250.0" RightPageBorder="250.0" />
</FBType> =
IFile changed

FIGURE 4-7 CLOSE UNSAVED FILE

Close All [File | Close All (Ctrl + Shift + W)]

Close all opened/created NCES models. A confirmation dialog will prompt out for every

unsaved file.

Exit [File | Exit (Ctrl + Q)]

Exit the VIiEd application. All tabs in the Visualization Panel will be closed and confirmation

dialog will prompt out for every unsaved file.

4.1.2 EDIT MENU
The Edit Menu provides commands to edit a NCES model.

The available options are as follows:

o Cut

. Copy
e Paste
e Delete

e Align horizontally
e Align vertically

Initially, when no NCES entity is selected all these menu items are disabled as indicated below:



FIGURE 4-8 EDITOR MENU

Cut [Edit | Cut (Ctrl + X)] ‘

Cut the currently selected NCES entity or group of entities. [Not supported in ViEd 1.0.0]

Copy [Edit | Copy (Ctrl + C)] ‘

Copy the currently selected NCES entity or group of entities. [Not supported in ViEd 1.0.0]

Paste [Edit | Paste (Ctrl + V)] ‘

Paste the previously cut/copy NCES entity or group of entities to the target location. [Not
supported in ViEd 1.0.0]

Delete [Edit | Delete (Delete)] ‘

Delete the selected NCES entity or group of entities.

Note: This operation cannot be undone.

Align horizontally [Edit | Align horizontally (Shift + H)]

Horizontally align the selected NCES entities in the Visualization Panel, such as places,
transitions, model instances, and their combinations. This command is enabled when multiple

entities are selected.
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FIGURE 4-9 ALIGN HORIZONTALLY: (A) SELECT ENTITIES, AND (B) AFTER ALIGNMENT

Align vertically [Edit | Align vertically (Shift + V)]

Vertically align the selected NCES entities in the Visualization Panel, such as places, transitions,
model instances, and their combinations. This command is enabled when multiple entities are
selected.
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FIGURE 4-10 ALIGN VERTICALLY: (A) SELECT ENTITIES, AND (B) AFTER ALIGNMENT

4.1.3 VIEW MENU

The View Menu contains commands to zoom in/out the Visualization Panel. By default, the
Visualization Panel displays the NCES models using the default dimensions. The Zoom tools
provide functions to enlarge or reduce the zooming factor of the Visualization Panel.

The available options are as follows:

e Zoom In
e Zoom Normal

e Zoom Out

Initially, when no NCES entity is selected all these menu items are disabled as indicated below:

FIGURE 4-11 VIEW MENU

| Zoom In [View | Zoom In (Ctrl + Plus)]

Increase the magnification of the current NCES model’s view.

‘ Zoom Normal [View | Zoom Normal (Ctrl + Equal)]

Reset the zooming factor of the Visualization Panel to the default value.

‘ Zoom Out [View | Zoom Out (Ctrl + Minus)]

Decrease the magnification of the current NCES model’s view.

4.1.4 OPTIONS MENU
Some properties of ViEd can be changed by selecting the corresponding items in the Options
menu. When an option is selected or toggled, a small tick icon « will be displayed next to the

toggled option as shown in Figure 4-12 (B).
The available options are:

e Show all comments

e Show page borders
e Lock page borders




e Always save compatible

Initially, when click the Options menu the following options will appear as shown in Figure 4-12
(A):

all comments | v Show all comments
v Show page borders
ders | v Lock page borders

Always save compatible | | v Always save compatible |

(A) (B)

FIGURE 4-12 OPTIONS MENU: (A) DEFAULT OPTIONS, AND (B) TOGGLED OPTIONS

Show all comments [Options | Show all comments]

Toggle all the comments on the NCES entities, such as places, transitions, and model instances.
By default, this option is switched off. The comments will be displayed in grey rectangle boxes
as shown below:
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FIGURE 4-13 TOGGLE ALL COMMENTS

Show page borders [Options | Show page borders]

Toggle the left-hand-side and right-hand-size borders of the current NCES model. The borders
are indicated by two vertical lines in grey as illustrated below:
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FIGURE 4-14 TOGGLE PAGE BORDERS

‘ Lock page borders [Options | Lock page borders]

Lock the positions of the page borders so that the page size is fixed.

‘ Always save compatible [Options | Always save compatible]

By toggling this option, the current NCES model will be saved in a compatible format that the
TNCES editor will recognize regardless of which save command (Save, Save as, or Save
Compatibility) is used. This is handy when developing models that can be recognized by both

ViEd and TNCES editor.

4.1.5 HELP MENU

The Help menu contains useful information about ViEd, such as the manual and contact details.

The Help menu contains two items:

e Help

e About
Help  Fl
About

FIGURE 4-15 HELP MENU

Help [Help | Help (F1)]

Display this ViEd manual as a HTML file.

About [Help | About]

Displays application information, version number, copyright information, and contact details as

illustrated below:
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FIGURE 4-16 ABOUT DIALOG

4.2 TOOLBAR

The Toolbar provides the quick access to the most frequently used Menu commands and
settings. There are a number of icons on the Toolbar as explained below:

o [ New (Ctrl + N): Creates a new NCES model.

.« = Open (Ctrl + O): Open an existing NCES model.

o Hsave (Ctrl + S): Save the current NCES model.

. HE Save as: Save the current NCES model with a different name.

e *Zoom In (Ctrl + Plus): Enlarge the zooming factor of current view in the
Visualization Panel.

° B‘ Zoom Normal (Ctrl + Equal): Reset the zooming factor to the default value.

.« = Zoom Out (Ctrl + Minus): Reduce the zooming factor of current view in the
Visualization Panel.

e = Show all comments: Toggle all the comments.

e | lShow page borders: Toggle the page borders.

o hdLock page borders: Lock the locations of the page borders.

4.3 SIDEBAR

The Sidebar is fixed to the top-left of the ViEd application window and contains the tools that
operate on the workspace in the Visualization panel. The selected tool determines what ViEd
does when click and drag the mouse on the workspace. For example, when the “Place” tool is
selected, a click on the workspace will create an NCES place entity, but when the “Transition”
tool is selected, a transition entity will be created. By default, the “Select Mode” is selected.
Short cut: press the “Esc” key to switch back to the “Select Mode”.

The available tools are:

« k Select Tool: Select, move, and transform NCES entities in the Visualization Panel
by clicking and dragging.

e ¥ Pan Tool: Pan around the workspace in the Visualization Panel by clicking and
dragging.

e _JPlace Tool: Create an NCES place at the current cursor’s location. ViEd will
automatically assign the appropriate ID to the created places. When a place is created,
it will have two names: the user defined name which is defaulted to [p + place ID], and



p1
the symbolic name. For example, as shown inO , the blue p1 is the default user
defined place name, and the green p1 is the symbolic name which cannot be changed.

L7 Transition Tool: Create an NCES transition at the current cursor’s location. ViEd
will automatically assign the appropriate ID to the created transitions. Similar to place,

ti
the transition has a default user defined name t1 and a symbolic name
Moreover, the V symbol indicates that the transition is in OR mode. In contrast,

t1
transition I:I represents a transition in AND mode.

A Arc Tool: Create an arc connecting two NCES entities. There are three different
types of arcs: event arc, condition arc, and flow arc. The type of created arc depends on
the types of the two connected entities. For example, a condition arc will be created
automatically when connecting a condition input to a transition. The labels for the
different arc types are listed below:

0 Flowarc: —*

o Eventarc: —"—*

o Condition arc: —®

0 Invalid or unconnected arc: ——

0 Inhibition arc: — ' (not supported in the current NCES formalism)

“>* Event Tool: Create an event port on one of the two page borders. There are two
different types of event ports: event input and event output. When create an event port
at the left-hand-side page border, the event port will become an event input; whereas
create an event port at right-hand-size page border, the event port will become an
event output. ViEd will maintain the correct ID for each created event port. Similar to
places and transitions, event ports also have user defined names and symbolic names.
The naming convention of event ports’ symbolic names are:
eil
0 Event input: ei + [Event Input ID], such as ©

0 Event output: eo + [Event Output ID], such as
*0 Condition Tool: Create a condition port on one of the two page borders. Similar to

o depending on which border side the condition port is created, there condition port
can be either condition input or condition output. ViEd will maintain the correct ID for
each created condition port. The convention for naming condition ports’ symbolic
names are:

cil

0 Condition Input: ci + [Condition Input ID], such as -

col
0 Condition Output: co + [Condition Output ID], such as =

IX!{ Instantiation Tool: Instantiate an instance of an existing NCES model type. When
this icon is selected a [Open file] dialog will prompt out for selecting the target NCES
model type to be instantiated. Once a valid NCES model type is selected, the cursor
will change to the Precision Select icon (usually a cross similar to =+). By clicking on
the desired position in the Visualization panel, the selected NCES model type will be
instantiated. After a model type is instantiated, ViEd will assign it a default name;
however, it is highly recommended that the default name is renamed to a meaningful
one. The naming convention for the default name is: New + [Model Type Name] +
[Instance ID]. For example, NewE_AND1 means the first instance of model type E_AND.



Note: the current NCES formalism does not support the mixture of basic entities,
such as places and transitions, and model instances. Therefore, if you
instantiate a model type in a basic NCES module all the basic entities will lost
without giving a warning. This is a known issue.

4.4 PANELS

Panels are sub-windows within ViEd’s main application window that let you control various
options and settings of the NCES model being developed. Each Panel has an Expand [+] and a
Contract [4] button. The Expand button maximizes the corresponding Panel’s size, whereas the
Contract button minimizes the current Panel’s size. There are six panels in ViEd as follows:

e Visualization Panel
e OQutline Panel

e Property Panel

e Interface Panel

e XML Panel

e Console Panel

Changes made in one Panel will be automatically reflected in all related Panels. For instance,
adding a new event input in the Visualization Panel will simultaneously add a new event input
in the Interface Panel.

4.4.1 VISUALIZATION PANEL

The Visualization Panel is the main engineering area, which displays the content of NCES
models in different tabs. In order to standardize the design approach and facilitate the
development process, both basic and composite NCES models share the same tab view in the
Visualization Panel. The text displayed in each tab is the model name, and the * icon next to
the model name is used to close the tab.

By double clicking on a model instance inside a composite NCES model will display its content
in a new tab and the focus will switch to the new tab automatically.

You can press the Ctrl or Shift key and drag the mouse to select multiple NCES entities in the
Visualization Panel. When entities are selected you can press the Delete key to delete them.
Note: the delete operation cannot be undone.

You can use various tools in the Sidebar to create places, transitions, and so on in the
Visualization Panel. Any change made in the Visualization Panel will immediately be reflected
to all the other Panels, and vice versa.

Add arc bend
Remave arc bend
Straighten arc
Shaow all comments
Show page borders
Lock page borders

FIGURE 4-17 CONTEXT MENU IN VISUALIZATION PANEL



When right-clicking on empty area or any NCES entity inside the Visualization Panel, a context
menu will appear as shown above. The context menu is an alternative way to select the
commands in the Main Menu and Toolbar.

Note: The “Add arc bend”, “Remove arc bend”, and “Straighten arc” functions has not been
implemented in ViEd 1.0.0.

4.4.2 OUTLINE PANEL

The Outline Panel displays the components in the current NCES model in a sorted hierarchical

tree structure. Depending on the type of current NCES model, the Outline Panel will display
one of two trees: Basic Tree or Composite Tree.

e Basic Tree View
The Basic Tree lists all the components within a basic NCES model as illustrated below:
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FIGURE 4-18 BASIC TREE VIEW

The text “New” besides ™ indicates the name of current NCES model. All the NCES
components are sorted and listed in under the corresponding branch in the tree.
Clicking on the entity’s name in the Outline Panel will select the corresponding
component in the Visualization Panel. The branches of the Basic Tree can be expanded
or collapsed by clicking the respective # and = next to the branch’s name. When a
branch is empty no # or = will appear besides it.

The available branches in a Basic Tree are listed below:

o £ Places: list all the places in current basic NCES model. Places are sorted
according to their creation order (the internal Num attribute in the XML file).
o [ Transitions: list all the transitions in current basic NCES mode. Transitions

are also sorted according to their creation order.

o M Arcs: list various arcs of current NCES model. Flow arcs are represented as

P

. . .. [ ]
; event arcs are indicated byf““r ; and condition arcs are shown as < . The

label ¥ p1 -> t1 indicates a flow arc connects place P1 and transition Ti.



o M Inputs: list all the input ports in the NCES model. An event input is
indentified by the 4 icon, whereas condition input is represented by ™.
o M Outputs: list all the output ports in current NCES model. An event output

is represented as K> and a condition output is show as P .
e Composite Tree View
The Composite Tree lists all the entities within a composite NCES model as shown

below:

E Top level
= E Mew
=X} Instances
s E MNewEIWaoW1 [EI".-".'":I".'"."]
— l,f'.f Arcs
© b el - MewEIWoW1 EI
- ¥ MewEIWoW1.InvokeECC - 2ol
P e M NewEIWoW1EISet -5 col
— =¥ Irputs
= il
R O il
—I-D Cutputs
[ |

FIGURE 4-19 COMPOSITE TREE VIEW

Unlike Basic Tree, Composite Tree does not contains places and transitions as current
NCES formalism does not allow mixture of basic entities and model instances. Instead,
the Composite Tree only lists all the model instances inside the model and their
connections with each other and the external ports.

The available branches in a Composite Tree are listed below:

o X! Instances: list all the model instances inside current model. The label “ &
NewEIWoW1 [EIWoW]” indicates a model instance called NewEIWoW1 of
type EIWoW. The model instances are also sorted by creation order.

o A Arcs: similar to Basic Tree, except that ports of a model instance are

” o«

labelled as “Model Instance name”. “Port name”.
o M Inputs: same as Basic Tree.

o P Outputs: same as Composite Tree.

4.4.3 PROPERTY PANEL

The Property Panel displays various property of the currently selected NCES entity or group of
entities. According to the type of selected entity, the Property Panel will display the respective
property fields. The drop box on the top of the Property Panel lists all the selected entities’
names, which allows you to switch among different entity’s properties. This is extremely useful
when you want to precisely select a certain entity in a very large model. The 44 button beneath
the Property Panel is used to commit the changes made in the Property Panel and update other
Panels. Moreover, each field in the Property Panel has some error-checking mechanism, which
prevents invalid values to be committed. For example, the Marking field in the Place view as
shown in Figure 4-21 can only contain integers. If you entered a letter in the Marking field and

pressed the < button, no action will be performed until you specify a valid value.



Hint: after changing the properties, pressing the cartridge return key is a shortcut to press the
€3 button.

Note: any unvisible character or invalid XML character in the [Comments] fields will be
automatically deleted when parsing the NCES model.

There are six different views of the Property Panel:
0 Model Type View:
MNew v

Type: Mew
Type Commenks:

FIGURE 4-20 PROPERTIES OF CURRENT MODEL

The Model Type View is the default view displayed in the Property Panel. It allows you

to specify the name of current model and its comments. You can always switch back to
the Model Type View by clicking the empty area inside the Visualization Panel and the
text in the Type field will be automatically highlighted.

0 Place View:

pl -
Mams: |pl
Symbalic: |p1
Marking: |0
Capacity: |1
Clock: |0

Comments:

FIGURE 4-21 PROPERTIES OF PLACE

The Place view provides direct access to various properties of a place entity, such as the
name, marking, capacity, clock, and comments.

0 Transition View:
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FIGURE 4-22 PROPERTIES OF TRANSITION

The Transition view allows you to modify the name, inscription, event mode, switch
mode, sychroset, and comment of a transition. When a transition is created, it is
default in Spontaneous OR mode.

0 Arc View:
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FIGURE 4-23 PROPERTIES OF ARC

The Arc view specifies the properties, such as capacity, time/permeability interval, type,
and geometry properties of the selected arc.

The capacity property only allows values greater than zero, any invalid value will be
automatically converted to 1.

The time/permeability property field is only usable when the selected arc is of type

flow arc. Moreover, to specify the value -2 is used to represent the infinity .

If the selected arc is an event arc, then its type cannot be altered. In contrast, if a flow
arc or condition arc is selected its type can be change to Flow Arc, Condition Arc, or
Inhibition Arc by choosing the corresponding item in the drop box next to Type.
Note: The ViEd 1.0.0 only supports straight arc segments. The other Geometry modes
are not implemented yet.

0 Model Instance View:
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FIGURE 4-24 PROPERTIES OF MODEL INSTANCE

In the Model Instance view, you can change the name, and comments of a selected
model instance. The first comment block is the comment for the selected model
instance, whereas the second comment block (Type Comments) is for the model type.
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FIGURE 4-25 PROPERTIES OF PORT

When a port entity is selected, for example an event input, the Property Panel will
display the port’s name and the comments for it.

4.4.4 INTERFACE PANEL

The Interface Panel is not an editable area. It only shows the interface of current NCES model
and will be automatically updated when changes made in other related Panels.

(A) B)

FIGURE 4-26 MODEL INTERFACES: (A) DEFAULT INTERFACE, AND (B) INTERFACE WITH PORTS

As illustrated in the above figure, Figure 4-26 (A) shows the default interface when a new NCES
model is created. The interface consists of two names: the top Instance Name in yellow and the



bottom Type Name in green. When ports are added to the model, only their user defined names
will be displayed on the interface as illustrated in Figure 4-26 (B).

4.4.5 XML PANEL

The XML Panel displays the XML file of the current NCES model. After pressing the update
button G"immediately above the XML Panel, any change made in the XML Panel will be
reflected in all the other Panels. Similarly, the XML Panel will also automatically reflect changes

made in other Panels. If no change made to the XML file, then the update button € is
unusable.

Note: The current version of ViEd uses a local XML Schema file to validate the XML files.
The validation process is only performed when the XML file is opened or saved. Moreover,
depending on the path of the current working directory of ViEd, the XML Schema file’s
location appeared in the XML Panel may not be the same. However, ViEd will always use
the XML Schema stored in \xmISchema\NCESModuleNetworkExtended.xsd.

4.4.6 CONSOLE PANEL

The Console Panel displays the internal information of ViEd, such as parsing input XML file,
and any error message occurred. The Console Panel’s content can be cleared by press the [Clear]
button on the Status Bar.

Hint: When the Console Panel’s content changed, an asterisk sign (*) will appear next to the
word “Console”.

4.5 STATUS BAR

The Status Bar is at the bottom of the ViEd application window and is used to display messages
of various operations. For instance, messages about whether the current file has been changed
or not. The Clear button at the right hand side of the Status Bar is used to clear the messages
displayed in the Console Panel, which is only usable when the Console Panel is active.

'=i|e changed Clear

FIGURE 4-27 STATUS BAR

5 TUTORIALS

This chapter presents worked examples of how you can use ViEd to create NCES models and
exposes the techniques of using various commands mentioned in the early chapters. This
chapter is broken into step-by-step tutorial that will take you through the process of creating a
basic NCES model and then a composite model. The final model can be later verified in the
Visual Verifier.

5.1 CREATING BASIC NCES MODEL TYPE

This section guides you to create your first NCES model. After starting the Visual NCES Editor
application, simply follow the steps below

Step1. Create a new NCES model

Select File | New or click the [3 icon to create a new NCES model. This will bring a new
tab in the Visualization Panel. You should get something like:
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FIGURE 5-1 CREATE NEW NCES MODEL

Step 2. Define the model’s interface

After creating a new NCES model, we need to define the model’s interface such as model
name, event and condition ports. We first position our cursor inside the Visualization
Panel and click the left button. This will bring us the Model Type View in the Property
Panel as shown below:
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FIGURE 5-2 DEFINE MODEL INTERFACE

The Property Panel shall display the default type name of current model, which is called
“New”, and a text field for entering comments about this model. Let’s call our new model:



MyfFirstBasicModel, and enter text “This is my first basic NCES model” to the comment field.

Then press the ¥ button underneath the Property Panel to commit the changes. You
should get something like:
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FIGURE 5-3 DEFINED MODEL INTERFACE
Next, we will add event and input ports and some NCES entities to our model.

Step 3. Define the model’s content

Now we are ready to start designing our model. First, we want to add one event input and
one condition output to our model, so that is can somehow communicate with other

models. To achieve this we need to do the following things:

1. Select the Event Tool “* in the Sidebar.

2. Position the cursor to the left page border inside the Visualization Panel and click
the left button. [Hint: you can turn the option Options | Show page borders on, so
that the page border will always visible.] An event input called ei1 will be created.
Remember, depending on which page border you click the ViEd will intelligently
decide the type of port, which in this case is an event input.

3. Select the newly created event input ei1. The symbol of ei1 should be highlighted in
red and the Property Panel should display its properties. Now we can change the
default name ei1 to some meaningful name, for example, START. Press the update
button underneath the Property Panel you should get something like:
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FIGURE 5-4 ADD AN EVENT INPUT

Notice that the Interface Panel, XML Panel, and Outline Panel are also updated at the
same time.

4. In asimilar way, we can easily create a condition output. Simply repeat the last two

steps but this time we need to select the Condition Tool *Oand click at the right
page border. We will rename the condition output to ENABLED and commit the
change.

Next we can add some other NCES entities, such as places transitions into our design:

1. Select the Place Tool ) in the Sidebar, position the cursor inside the Visualization
Panel and click the left mouse button. Then, a place called p1 will be created at the
cursor’s position. Similar to port, we can select p1 and modify its properties in the
Property Panel. In this case, we will make the initial marking of p1 to 1.

2. To add a transition, select the Transition Tool in the Sidebar and repeat the
procedure mentioned above. At last, you can create something like:
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FIGURE 5-5 ADD PLACES AND TRANSITIONS

3. The places and transitions are not properly aligned. To align the places vertically
we first select both of them by dragging the mouse or holding Ctrl and clicking on
them. Then, we right click on the highlighted box which will bring us the context
menu as shown below:
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FIGURE 5-6 ALIGN PLACES VERTICALLY

Now we can select the Align horizontally command and the two places will be
aligned automatically. We can repeat the same process to the two transitions but
this time we want to align them horizontally. The resultant model should look like:
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FIGURE 5-7 ALIGNMENT RESULT
4. Finally, we need to connect the places, transitions, and ports. To add an arc, we
need first to select the Arc Tool ¥ in the Sidebar and move the cursor to the
source entity of the arc. Click the left button of the mouse to create a grey arc.
Move the cursor to the destination entity of the arc and click the right button to
release the arc. If the arc turns into blue, it means the arc has been created
successfully. If it remains grey, then perhaps you missed the destination entity. In
this case, switch to the Select Mode k in the Sidebar; select the arc and move its
arrow head to the current position and the ViEd will automatically connect it.
Alternatively, you can simply delete the arc and redraw a new one.
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FIGURE 5-8 STRAIGHT ARC

Sometimes, we may want to make polygonal arcs with one or more intermediate
points. This can be achieved by simply click the left mouse button at the point you
want the arc to bend when drawing an arc. The following figure shows an arc t2-

>p1 with one intermediate point:
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FIGURE 5-9 POLYGONAL ARCS

At last, we can connect the event input START to t1 and p2 to condition output
ENABLED as connecting places and transitions. Arc type is determined
automatically according to the context, i.e. the type of source and destination
entities. In a case of ambiguity, for example an arc from a place to a transition can
be either a flow arc or a condition arc; the type is assigned by default as flow arc.
However, you can easily change it in the Arc View of the Property Panel. The final
design of our first basic NCES model should look like:
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FIGURE 5-10 FINAL BASIC MODEL
Step 4. Save the created NCES model
When everything is done, we can save our first model by clicking the & button or

selecting File | Save, or using the shortcut Ctrl + S. The first time you save a model, a Save
File dialog will appear ask you for the model name as:
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FIGURE 5-11 SAVE NCES MODEL

Note: If you are going to use models created by ViEd in TNCES editor you must ensure that
the model type name is identical to the file name you saved.



5.2 CREATING COMPOSITE NCES MODEL TYPE

You can solely model the target system by creating a large basic NCES model. However, this
will make the overall design unmanageable and unwieldy. Instead, composite NCES models are
networks of other models, which can also be composite. Composite models modularize the
design and can precisely reflect the target system’s real structure or layout.

This section demonstrates you the basic steps to create a composite model type.
Step1. Create a new NCES model

A composite NCES model is created in the same way as basic NCES model. In this case, we
create a model called MyFirstCompositeModel.

Step 2. Instantiate model types

To make a composite model, we need to instantiate other model types. We will reuse our
first basic NCES model created before. However, composite model also can contain
instances of other composite model types. To instantiate a model type, we first select the
Instantiation Tool {X} in the Sidebar. Then we mouse the cursor to the Visualization Panel
and click the left button to bring the Open File dialog to choose the target model type as
shown below:
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FIGURE 5-12 INSTANTIATE A MODEL TYPE

After we chose the MyFirstBasicModel.xml file, the cursor will change to the Precision

Select icon (e.g. <) and we can left click at the place we want to put our instance. We will
instantiate two instances of model type MyFirstBasicModel. The result should look like:
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FIGURE 5-13 INSTANTIATION RESULT
Same as places and transitions, model instances can also be aligned in the same way.
Step 3. Connect the model instances

Same as connecting basic NCES entities in basic NCES model, model instances in a
composite model are connected by using the Arc Tool. In this example, as we did not create
any input/output so we cannot connect our model instances. Usually, a composite model
without any input/output is called autonomous. In most cases, you need to create
autonomous composite models to perform testing operations.

Step 4. Save the final model

Composite models are also saved in the same way as basic NCES model. However, in order
to distribute the composite model, you must also include all the sub-models inside the
same folder you want to distribute. Otherwise, when open the composite, ViEd will
complain that some files cannot be found in the current working directory and ask whether
you would like to manually locate the missing files:

(] File not found.

FIGURE 5-14 MISSING FILE DIALOG



6 FAQ

After extracting the archive, why the ViEd cannot run?

ViEd is developed with JDK 1.6. Therefore, in order to run ViEd you must install JRE 1.6
or above.

Does ViEd can be run in Linux?

Although ViEd is developed in Java, it currently has not been ported to Linux.

Why my ViEd freezes for no reason?

This may be caused by various reasons. In general, whenever a runtime error occurs, an
error.log file will be created inside the ViEd folder which lists all the error messages.

Workarounds for the known bugs and issues are listed in the Known Bugs and Issues

section.

KNOWN BUGS AND ISSUES

No warning message prompt out when instantiate a model type in a basic NCES
module. The content of the basic NCES module just simply disappears. Also this
operation is not reversible.

Menu item on File menu will not be re-disabled again once enabled. For example,
initially the Save, Save As, etc, are unusable, however after a new file has been created
or an existing file has been opened and then closed these items will not be disabled
again. This also applied to the Toolbar items.

After creating an inhibition arc, the capacity of places is fixed to one and cannot be
changed anymore. To unlock the capacity field, a new arc of any type must be created
and selected. Then the capacity field will be back.

When reopen a composite NCES model, all the internal arc connections screw up. The
connections are still correct however just the graphical rendering does not work
properly. By slightly moving the instances, the arc connections will be re-connected.
When using Save As to save current model in a different name, if the full name (name +
extension) are not given, then the model will not be saved. You must specify the full
name to solve it.



